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End-User Software License Agreement 

This MecSoft Corporation's VisualTurn End User Software License Agreement that accompanies the 

VisualTurn(TM) software product (ñSoftwareò) and related documentation ("Documentation"). The term 

"Software" shall also include any upgrades, modified versions or updates of the Software licensed to you by 

MecSoft. 

MecSoft Corporation grants to you a nonexclusive license to use the Software and Documentation, provided that 

you agree to the following: 

1. USE OF THE SOFTWARE. 

You may install the copy on multiple computers.  You may not have more than the legally purchased number of 

licenses of Software running concurrently at one time.  

2. COPYRIGHT.  

The Software is owned by MecSoft Corporation and its suppliers. The Softwareôs structure, organization and code 

are the valuable trade secrets of MecSoft Corporation and its suppliers. The Software is also protected by United 

States Copyright Law and International Treaty provisions. You must treat the Software just as you would any 

other copyrighted material, such as a book. You may not copy the Software or the Documentation, except as set 

forth in the "Use of the Software" section. Any copies that you are permitted to make pursuant to this Agreement 

must contain the same copyright and other proprietary notices that appear on or in the Software. You agree not to 

modify, adapt, translate, reverse engineer, de-compile, disassemble or otherwise attempt to discover the source 

code of the Software.  Trademarks shall be used in accordance with accepted trademark practice, including 

identification of trademark ownerôs name.  

Trademarks can only be used to identify printed output produced by the Software. Such use of any trademark does 

not give you any rights of ownership in that trademark. Except as stated above, this Agreement does not grant you 

any intellectual property rights in the Software. 

3. TRANSFER. 

You may not rent, lease, sublicense or lend the Software or Documentation. 

4. LIMITED WARRANTY.  

MecSoft Corporation warrants to you that the Software will perform substantially in accordance with the 

Documentation for the thirty (30) day period following your receipt of the Software. To make a warranty claim, 

you must notify MecSoft Corporation within such thirty (30) day period. If the Software does not perform 

substantially in accordance with the Documentation, the entire and exclusive liability and remedy shall be limited 

to either the replacement of the Software or the refund of the license fee you paid for the Software. 

MECSOFT CORPORATION AND ITS SUPPLIERS DO NOT AND CANNOT WARRANT THE 

PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE. THE FOREGOING 

STATES THE SOLE AND EXCLUSIVE REMEDIES FOR MECSOFT CORPORATIONôS OR ITS 

SUPPLIERSô BREACH OF WARRANTY. EXCEPT FOR THE FOREGOING LIMITED WARRANTY, 

MECSOFT CORPORATION AND ITS SUPPLIERS MAKE NO WARRANTIES, EXPRESS OR IMPLIED, AS 

TO THE NON-INFRINGEMENT OF THIRD PARTY RIGHTS, MECHANTABILITY, OR FITNESS FOR 

ANY PARTICULAR PURPOSE. IN NO EVENT WILL MECSOFT CORPORATION OR ITS SUPPLIERS BE 

LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES, INCLUDING 

ANY LOST PROFITS OR LOST SAVINGS, EVEN IF A MECSOFT CORPORATION REPRESENTATIVE 
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HAS BEEN ADVISED OF THE POSSIBLITY OF SUCH DAMAGES OR FOR ANY CLAIM BY ANY 

THIRD PARTY. 

Some states or jurisdictions do not allow the exclusion or limitation of incidental, consequential or special 

damages, or the exclusion of implied warranties or limitations on how long an implied warranty may last, so the 

above limitations may not apply to you. To the extent permissible, any implied warranties are limited to thirty 

(30) days. This warranty gives you specific legal rights. You may have other rights which vary from state to state 

or jurisdiction to jurisdiction. For further warranty information, please contact MecSoft Corporationôs Customer 

Support. 

5. GOVERNING LAW AND GOVERNING PROVISIONS.  

This Agreement will be governed by the laws in force in the State of California excluding the application of its 

conflicts of law rules. This Agreement will not be governed by the United Nations Convention on Contracts for 

the International Sale of Goods, the application of which is expressly excluded. If any part of this Agreement is 

found void and unenforceable, it will not affect the validity of the balance of the Agreement, which shall remain 

valid and enforceable according to its terms. You agree that the Software will not be shipped, transferred or 

exported into any country or used in any manner prohibited by the United States Export Administration Act or 

any other export laws, restrictions or regulations. This Agreement shall automatically terminate upon failure by 

you to comply with its terms. This Agreement may only be modified in writing signed by an authorized officer of 

MecSoft Corporation. 

6. U.S. GOVERNMENT RESTRICTED RIGHTS 

Use, duplication, or disclosure by the government is subject to restrictions as set forth in subparagraph (c) (1) (ii) 

of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c) (1) 

and (2) of Commercial Computer Software ï Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer 

is: MecSoft Corporation, 18019, Sky Park Circle, Suite KL, Irvine CA ï 92614-6386, USA. 

Unpublished - rights reserved under the copyright laws of the United States. 

MecSoft Corporation 

18019, Sky Park Circle, Suite KL 

Irvine, CA 92614-6386 

VisualTurn is a registered trademark of MecSoft Corporation 

©  1998-2006+, MecSoft Corporation  

 

Trademark credits 

Windows is a registered trademark of Microsoft Corporation 

Pentium is a registered trademark of Intel Corporation 

Rhino is a registered trademark of McNeel & Associates. 
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Welcome to VisualTurn 

Welcome to VisualTurn and thank you for choosing one of most powerful and easy to use 2 Axis turn 

packages on the market today.  

VisualTurn is a unique, Windows-based, CAM product that seamlessly integrates toolpath generation 

and cutting simulation/verification, in one package that is both easy and fun to use. VisualTurnôs 

machining technology capabilities enable you to produce toolpaths that you can send to the machine 

with utmost confidence. A simple and well-planned user interface makes VisualTurn suitable for use on 

the shop floor. 

VisualTurn is a machining program targeted at the typical lathe machinist. It is ideal for machining 

cylindrical parts on the lathe. It can import Rhino, STL, IGES, STEP, DXF/DWG, VRML, and Raw 

Triangle files. 

Solid models, surface models and faceted models can be imported into VisualTurn, and a wide selection 

of tools and toolpath strategies to can be defined when generating toolpaths. These toolpaths can then be 

simulated and verified, and finally post-processed to the controller of your choice.  

About This Guide 

This guide is designed to introduce first-time users to VisualTurn 1.0. The first part describes aspects of 

the user interface, machining strategies, and turning types. This is followed by several tutorials designed 

to familiarize you with the main features of VisualTurn. 

In addition to the information provided in this guide, see the context-sensitive online help for more 

comprehensive explanations. You can also look at the models included in the Tutorials  folder.  

Computer Requirements 

Intel Pentium compatible computer 

Windows 98, NT, 2000, ME, or XP with at least 256 MB RAM. 

OpenGL-compatible graphics card, displaying at least 64,000 colors 

Approximately 50 MB of hard disk space. 
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Installing VisualTurn  

To install VisualTurn software, follow these instructions: 

1. Insert the CD-ROM into the CD ROM drive. 

2. The setup program will automatically launch once the computer detects the CD. 

3. If the program is not automatically launched, browse the CD using the Windows Explorer 

program and double click on the Launch program found in the CD.  This will launch the screen 

shown below: 

 

Step 1:  Install Drivers (Required) 

VisualTurn ships with a hardware security device called the security key (or ñdongleò). This is either a 

25-pin connector that connects to the parallel port of your computer, or a USB key that plugs into any 

USB port on your computer.   You will have to install the drivers to allow VisualTurn to communicate 

with this security device as the first step.  Click on the Install Drivers  button on the installation screen 

and follow instructions to install the drivers. 
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USB Port Security Key Parallel Port Security Key 

Note: Plug the hardware key into your computer only after you complete installation of all software.  

Once you have installed the drivers and the software you can attach the key to your computer.   

¶ If you have a parallel port security key and if you have any other device, such as a printer, 

connected through the parallel port, disconnect the device(s) and connect the VisualTurn security 

key to the port. Then reattach the connector of the original device(s) on top of the security key; 

the device(s) will continue to operate as before.  

¶ If you have a USB port key, attach the key to any free USB port on your system 

Make sure that the VisualTurn hardware key is connected to the computer.  VisualTurn will not operate 

correctly if the security key is not connected to the computer! 

Step 2:  Install VisualTurn (Required) 

Once you have installed the hardware key drivers and attached the key to your computer, you can install 

the VisualTurn product by clicking on the Install VisualTurn button on the main installation screen.   

Follow the instructions to complete the installation.  The install program will install all the files 

necessary for the proper functioning of VisualTurn but also will make necessary registry modifications 

on your computer. 

Note: Make sure you have privileges to modify the system registry before you install VisualTurn. 

Step 3: Install Other Products (Optional) 

Once you have installed VisualTurn you can optionally install MCU and/or Xpert DNC.  These are two 

third party products that are included with VisualTurn.   

¶ The MCU or Meta Cut Utilities product is a back-plot viewer that allows the user of VisualTurn 

to view the generated G-code graphically.  This can be useful in making sure the posted output is 

correct before sending it to the machine tool.   

¶ The Xpert DNC product is a single port DNC product is a communication program that allows 

you to send G-code files via DNC or Direct Numerical Control from your computer to the 

controller of the machine tool.   
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Step 4: Registering VisualTurn (Required) 

Upon successful installation, you can run the full VisualTurn version 50 times or for 30 days without 

registering the product. After this period, VisualTurn will not operate anymore. VisualTurn needs to be 

registered with MecSoft and valid license codes obtained before it can become operable again.  

To register VisualTurn, launch the product.  Once VisualTurn is loaded and ready, you will see the 

Enter License Codes dialog shown below. You can alternatively access this dialog by selecting the 

Help option in the menu bar and choosing Register VisualTurn. The Tries Left field indicates the 

number of times you can run VisualTurn before it starts operating in demo mode.  

 

Note: This registration dialog can also be invoked from the Help item in the VisualTurn menu bar. 

To obtain license codes you must register the product using the Web form available at 

www.mecsoft.com.  You can automatically launch this web form by selecting the Request License 

Codes button in the dialog.  If you have purchased the product directly from MecSoft Corporation, you 

will have to provide the purchase invoice number before you can be licensed.  If you have purchased the 
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product through an authorized MecSoft reseller, please obtain the license codes from your reseller.  In 

addition to this information make sure you also provide the Dongle ID that is shown on the registration 

screen.   

 

Network Installation of VisualTurn  

If you have purchased a network license of VisualTurn please follow the steps outlined in Appendix I 

for proper installation of the network enabled hardware key. 

 

Troubleshooting VisualTurn Installation 

If you have followed the installation steps outlined in the installation section correctly and are unable to 

load and run VisualTurn follow the troubleshooting steps outlined in Appendix II to correct the problem. 

 

Running VisualTurn  

Click on the Windows Start button and select Programs. Point to the program group containing 

VisualTurn . The name of this program group will be VisualTurn 1.0, unless you specified otherwise 

during setup. Once you locate the program group, select it and then select VisualTurn 1.0. 
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VisualTurn User Interface 

VisualTurn adheres to the Windows standard for user interface design. All functions can be accessed 

from the menus, and common functions are accessible via toolbar icons. Most user interface settings are 

modal - VisualTurn ñremembersò these settings and they remain active in subsequent operations unless 

you change them.  

The main VisualTurn user interface objects are described below: 

 

 

 

 

 

Note: You can control the display by selecting View / Toolbars.  

Status Bar: Displays current function or 

prompt, active tools, units, snaps, and 

cursor location 

View Bar: Zoom, pan, rotate, standard 

views, display/hide functions 

Browser: Displays geometry, 

machining operations, tools, 

and stock removal simulation  

Command Window: Enter values 

manually, or displays calculated values 

Standard Bar: File load/save, layer and 

selection control, and more  

Geometry Bar: Create and 

edit points, curves, and 

surfaces 

Measurement Bar: 

Measures dimensions 
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VisualTurn Browser Window  

The Browser is a dockable window that allows management of various entities or objects that can be 

created in VisualTurn.  This window is the principal window through with the user interacts with 

VisualTurn to program toolpaths.  By default, this window will appear docked on the left hand side of 

the VisualTurn display when the product first comes up.    This window can be undocked and moved to 

different locations on the main screen. 

This window has four main modes of operation represented by tabs at the top of the window. These are 

Setup, Tool, MOps and Stock. Selecting each of these tabs allows different views of objects in the 

VisualTurn database.  In addition each tabbed view also incorporates a context sensitive toolbar at the 

top.  These toolbars are groups of functions that are associated with the type of object(s) in the tab.    

 

 

For an in-depth description of each of the buttons in the toolbars please refer to the on-line help of the 

product. 

VisualTurn Toolbars  

VisualTurn comes with a set of toolbars with various functions to help the programming.  You can 

toggle toolbars by selecting View -> Toolbars in the menu bar and selecting the desired toolbar.  A 

description of each of these toolbars and their buttons is described in the Appendix of this document. 
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VisualTurn Workflow 

The manufacturing process aims to successively reduce material from the stock model until it reaches 

the final shape of the designed part. To accomplish this, the typical machining strategy is to first use 

large tools to perform bulk removal from the stock (roughing operations), and then use progressively 

smaller tools to remove smaller amounts of material (pre-finish operations). When the part has a uniform 

amount of stock remaining, a small tool is used to remove this uniform stock layer (finish operations). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This machining strategy is what you program using VisualTurn. You can also simulate material removal 

to visualize how the stock model will look at any time during the process. This provides valuable 

feedback that can help you choose the most appropriate machining strategy. 

 

Load Part & Stock 

Geometry 

Create Roughing 

Operations 
Simulate Material 

Removal 

Output Toolpaths 

to Machine 

Create Pre-Finish  

Operations 

Create Finishing 

Operations 
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Typical Scenario 

Rough machining can be done by Roughing operations, using a turning tool with a relatively large nose 

radius. These rough operations can be followed by subsequent roughing operations, either using the 

same tool or a smaller tool.  

Final finishing of the part can then be performed by using one or more Finishing operations. Finishing 

operations typically use tools with smaller nose radius so as to obtain a better surface finish and tighter 

tolerance levels. 

Depending on the geometry of the part and/or machining operations desired, Groove Roughing, 

Groove Finishing, Follow Curve, Threading and the Hole-Making operations can be considered. 

After completing all the machining operations, the final part is cut off from the rest of the bar stock by 

using the Part-Off  operation.  

Once all of the operations are completed, you can go back and review the operation sequence, re-order 

and/or change operations if desired, simulate the material removal, and post-process the toolpaths. The 

Browser can be used to manage these operations.  

 

Programming Workflow  

Once the part is loaded, the typical workflow is reflected in the layout of the tabs and toolbars of the 

Browser window.  The workflow is designed to allow the user to work starting from the left most tab 

and ending at the right most tab.  Additionally each of the functions in each of the toolbars 

corresponding to each tab is also best accessed in order from left to right. 

Thus the user typically would start with the Setup tab and access each of the buttons, optionally, in the 

toolbar that appears when this tab is selected in sequence from left to right.  Once the setup functions are 

completed, the user will then proceed to the Tools tab to create, select and save tools to be used in the 

machining.  After this the user will proceed to the MOps or Machining Operations tab and commence 

programming the part.  Once a program is completed the user can switch to the Stock tab to perform the 

material removal simulation and/or the tool animation to preview the toolpath before sending it to the 

machine tool. 
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Step 1:  Setup before programming Step 2:  Create, select and save tools 

  

Step 3:  Create machining operations Step 4:  Simulate machining operations 

  

     

Post-Processing 

Once the machining operations have been created and verified, they can be post processed to create G-

code files.  These G-code files can then be sent to the controller of the machine tool to drive the actual 

machine tool.   
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Machining Methods 

There are two major classes of machining operations that can be created in VisualTurn ï Turning and 

Hole-Making. Turning operations are used to remove material from cylindrical shaped stock on a lathe 

machine to get the desired shapes.  Hole-Making operations are used to create axial hole features in the 

part.  

Turning Operations 

Turning operations are operations used to create the shape of the part.  All 2-axis turned shapes can be 

represented as a surface or solid of revolution.  Turning operations are used to create the shape out of an 

initial cylindrical stock model. 

The various types of operations available in VisualTurn are described below: 

  Roughing 

This operation is typically performed to remove material from the stock, thus is characterized by 

larger depth of cuts.  Typically material is roughed out in multiple cuts. This type of machining is 

very efficient for removing large volumes of material, and is typically performed with a large radius 

tool. Roughing is typically followed by finishing toolpaths. 

Both part and stock geometry are used to determine the regions that can be safely machined. 

Roughing can be of 3 types: OD Roughing, ID Roughing, and Front Facing (Face Roughing) 

      

Outer Diameter (OD) Roughing        Inner Diameter (ID) Roughing 
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Face Roughing 

 

Cut patterns: Two types of cutting patterns are available: Linear  (parallel to the Z-axis), Offset 

(parallel to the part region). 

       

 

Roughing ï Linear           Roughing ï Offset 
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  Finishing 

This operation is performed after roughing operation. Only the part geometry is taken into 

consideration in this machining operation and is offset to calculate the finishing tool-path. This 

operation is characterized by smaller depth of cuts to obtain tighter tolerances and better surface 

finish. 

     

OD Finishing             ID Finishing 

 

 

 

Face Finishing 
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  Groove Roughing  

This operation is performed to machine grooves on the part. The grooves are typically used to 

slide/fit one part into another to obtain the required assembly. 

 

 

 

  Groove Finishing  

This operation is used to finish the grooves. This operation is performed after the Groove Roughing 

operation.  
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 Follow Curve 

This operation is performed in difficult to reach areas.  The tool is driven about the curve with no 

offsets applied to the curve.   

 

 

  Threading  

This operation is performed to machine threads on the part. Threads are used as fasteners for 

assembly purposes. 
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  Part Off  

This operation is performed to cut off the finished part from the rest of the bar stock. 

 

 

All the turning operations as mentioned above, except Part Off , can be carried on the Outer Diameter, 

Inner Diameter or the Front Face of the work-piece. 

Hole-Making Operations 

Hole making operations in a 2-axis turning machine are always performed axially.  That is only holes 

that are aligned with the rotation axis of the part and also on the front face of the part can be created.  An 

example of an axial hole is shown below.  The part is chucked on the lathe as usual and the hole-making 

tool is moved along the axis of rotation to create the hold. 
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The various types of hole-making operations available in VisualTurn are described below: 

 

 Drilling - The following drill cycles are available:  

Standard: Used for holes whose depth is less than three times the tool diameter. 

Deep: Used for holes whose depth is greater than three times the tool diameter, especially when chips 

are difficult to remove. The tool retracts completely to clean out all chips. 

Counter Sink: Cuts an angular opening at the end of the hole. 

Break Chip:  Similar to Deep drilling, but the tool retracts by a set clearance distance. 

 

 Tapping 

A Tap cycle is used to drill threaded holes in the part, clockwise or counter-clockwise.  

 

 Boring 

A Bore cycle is used to form shapes inside a hole. The following boring cycles are available:  

Drag: The tool is fed to the specified depth at the controlled feed rate. Then the spindle is stopped and 

the tool retracts rapidly. 

No Drag:  The tool is fed to the specified depth at the controlled feed rate. It is then stopped to orient 

the spindle, moved away from the side of the hole and then retracted. 

Manual:  The tool traverses to the programmed point and is fed to the specified depth at the controlled 

feed rate. Then the tool stops and is retracted manually. 

 Reverse Boring 

This is simply a Bore cycle in the reverse direction. The spindle is oriented to the specified angle and 

moves rapidly to the feed depth and moved to the part. The spindle is turned on and the cycle is 

started. 
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X 

Key Concepts in VisualTurn Programming 

Before attempting to use VisualTurn there are a few key concepts that are used in VisualTurn that need 

to be understood.  Some of these concepts will be familiar to lathe programmers and are explained here 

because they are essential for the proper use of VisualTurn. 

Turning Coordinate System 

CNC turning centers use the Cartesian coordinate system for programmed coordinates but they are 

typically different from that used in milling.  Turning centers follow the convention that axis of rotation 

that is aligned with the spindle is designated as the Z axis.  Secondly the axis perpendicular to this axis 

along which the tool travels to cut into the stock is designated the X axis.  Thus the part is rotated about 

the Z-axis of the lathe machine. Moving the tool along the Z-axis provides the direction of feed and 

moving it along the X-axis provides the depth of cut.  This is shown below. 

 

 

VisualTurn Default View 

VisualTurn uses the Top view as the default view.  This top view is additionally setup to be aligned with 

the turning coordinate system.  That is the origin of the screen is located at the center of the screen and 

the Z axis goes from left to right and the X axis goes from bottom to top.  This display setup is not 

typical in design systems where the Top view is aligned with the XY axes of the world coordinate 

system.   This view setup is used in VisualTurn to allow the turning center programmer to work in 

turning center coordinates rather than in the XY coordinates of the design system. 

It should be noted that this convention might sometimes be disorienting for users who are used to 

visualizing their design parts in the normal XY aligned display rather than the ZX aligned display.   

Note: VisualTurnôs Top view is by default aligned with the ZX turning center coordinate system.  

Z 
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Part Geometry 

VisualTurn requires regions/curves that define the part geometry.  Since all parts that can be created in a 

2-Axis turning machine are solids of revolutions, it is enough to describe the profile that needs to be 

revolved to create this shape.  The profile can be created in VisualTurn as a region or curve.  

Furthermore VisualTurn places a further restriction that these part regions need to be constrained to lie 

only in the first quadrant of the ZX plane.  That is, one end point of the region must touch the X axis and 

the other end of the profile should touch the Z axis.  VisualTurn will be unable to process a part region 

that does not follow these restrictions. 

 

Valid part region: Region correctly positioned in the first ZX quadrant touching both the X and Z axis 

  

Invalid part regions:  Region is not touching the X axis and/or Z axis 

 

Note: Part regions need to be constrained to the first quadrant of the ZX coordinate system.  
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Part Regions can be imported or can be created within VisualTurn using the Geometry creation and 

editing tools of VisualTurn. You can select a part of the region or the whole region for machining 

purposes.  The Geometry Bar contains all the tools you need to create regions, in addition to other types 

of geometry. It is located to the right of the graphics area. If you do not see this toolbar, select View / 

Toolbars / Geometry Bar.  

Selecting Regions 

Regions must be selected in order for them to be used in an operation. Creating a region does not make 

it active; you must use one of the Select Regions tools before creating the toolpath. 

Region selection tools can be accessed from the Select Regions icon. These tools are also available in 

the Mops tab. 

 

When selected, a region is highlighted in yellow (depending on the color preferences set). Note that any 

selected regions remain active until deselected, so when you want to activate different regions be sure to 

deselect any you do not want. 

The following region tools are available: 

 Single: You can select existing regions by picking them manually. Multiple regions can be selected 

by pressing Ctrl. 

 Rectangle: Selects all regions within a defined rectangle. 

 Polygon: Selects all regions within a defined polygon. 

 All: Selects all regions defined in the model. 

 None: Deselects any selected regions. 
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Using 3D Geometry as Part Geometry 

VisualTurn has the capability of extracting 2D profile from a 3D geometry.   Since VisualTurn uses wire 

frame geometry (regions) to define the part geometry, created or imported 3-D geometry cannot be used 

directly.   Using the Slice and Resolve Part Region tools provided in the Setup tab toolbar of the 

browser window the user can easily create 2D geometry that can then be used as input to the VisualTurn 

toolpath generation methods.  The Slice button slices the input 3D model with and infinite XZ plane and 

creates one or more regions/curves in VisualTurn.  The Resolve Part Region button extracts a part 

region that is completely inside the first quadrant of the ZX coordinate system by either trimming the 

region against the axes and or extending the ends of the regions to the closest axes.  Once resolved these 

part regions can then be used as part geometry for the VisualTurn toolpath generation methods.  

Note:  Refer to Tutorial 1 for more information on Slice and Resolve Part Region commands 

 

Setting up Imported Geometry 

As mentioned earlier design systems use the normal Cartesian system for designing parts.  So parts 

models will usually have the axis of rotation aligned with the global X axis and the radial direction 

aligned with the global Y axis.  When you import such a model into VisualTurn there is an easy way of 

converting the geometry such that the axes are properly aligned with the turning center coordinate 

system.  Selecting the Convert XY to ZX  button in the Setup tab toolbar of the Browser window 

will perform this transformation automatically.  This command works for both 2D & 3D geometry.  

Follow these steps for performing the necessary transformation. 

Steps for Converting XY to ZX for a 3D geometry 

1. Load the 3D geometry into VisualTurn. 

2. Select  Convert XY to ZX from the Setup Tab of the VisualTurn Browser. 

This will orient the curve to the ZX (lathe coordinate system) 

Steps for Converting XY to ZX for a 2D geometry 

1. Load the 2D geometry into VisualTurn. 

2. Select  Convert XY to ZX from the Setup Tab of the VisualTurn Browser. 

3. Make sure the 2D trace touches the X and Z of the coordinate axis. 

4. Use the transformation tools from the Edit menu to move the geometry to the 1
st
 quadrant 

of the lathe coordinate system if necessary.  
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Stock Model Setup 

ñStockò represents the raw stock from which the part will be manufactured. Stock geometry can either 

be created within VisualTurn or imported from an external file. Stock can also be created within 

VisualTurn by entering the length and radius of the cylindrical stock or as the bounding cylinder of the 

part. You can also define stock as an offset, both in the radial and axial direction of the part geometry, to 

simulate casting or forging raw stock model. 

Note: Stock can be created only after part geometry is created or loaded in VisualTurn. You must 

define a stock model before creating Turn Roughing and Groove Roughing operations. All other 

operations can be created without first creating a stock model. 

To create stock models select Create/Load Stock from the Setup tab to select the stock type. (This tool 

is also available on the Stock tab of the Browser.) 

     

The various types of stock models that can be created in VisualTurn are described below: 

Cylinder Stock: In this type of Stock model user can specify the Radius (Outer and Inner) and 

Length (Major and Minor) for the stock.  
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Part Cylinder Stock:  Here a cylinder that encompasses the part completely in the Z and the X axis 

can be created.  The user can additionally specify a Radial Offset and/or Axial Offset for the stock. 

  

 

Part Offset Stock:  User needs to select a 2D part region before creating a Part Offset Stock. User 

can then specify offset value to create the stock model.  The part region will be revolved around the 

Z axis after an uniform offset applied to the region 

 

2D Part Region  
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Revolve Stock: User needs to select a 2D profile before creating a Revolve stock. The above curve 

is used to create a revolve stock for this example. 

    

2D Profile 

Import Stock: User can import STL solid models (ASCII and binary) for stock geometry. Surfaces 

can be imported from IGES or Rhino 3DM. Faceted (triangulated) models can be imported from 

VRML, Raw Triangle, DXF / DWG facet data, or Rhino Mesh.  Note that in-order for the import 

stock to work correctly it needs to be a water tight model.  Gaps between faces of the model will 

result in problems during the creation of the stock model. 

Tip: Stock is used for simulation, and its display involves data-intensive rendering. This can slow 

down VisualTurnôs performance. Therefore, we recommend turning off the stock display when not 

needed. 

Stock Model Display:  The stock model is created and switches to the Stock tab of the Browser. 

The stock is displayed as a cylinder positioned at the reference point of the lathe machine. Its color 

can be set in the Color Preferences.  If you are unable to see the stock, make sure the Hide Stock 

toggle icon in the View bar is turned off. 
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Setting up the Machine Coordinate System 

Before we start machining, the machine co-ordinate system has to be set. This allows us to define the 

program zero, with respect to which the tool-paths are calculated and output.  The program zero is 

variously called work datum, program reference point and work zero etc.  This point defines the 

coordinate origin of the program.  All program points output to the machine tool are described with 

respect to this point.    

In typical shop floor practice, this program zero point is set at a position such that the X coordinate of 

this point is on the axis of rotation and the Z coordinate of this point is flush with the right most face of 

the work-piece or stock. 

VisualTurn allows the user to specify this program zero point conveniently by using a dialog.  To set the 

program zero, or to set the MCS follow these steps: 

1. Click on the Set MCS icon in the Mops tab of the Browser Bar or Double-Click on the Set MCS 

under Machining Operations  

 

2. This gives the user different options to set the machine zero. The user can set the zero to the 

left/right face of the part/stock box or pick the point directly. 

3. As mentioned above the general shop floor practice is to set the MCS origin to the Stock Box and 

Zero Face to Right Most face of the part. Click OK .  
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This should align the MCS with the rotation axis and the right most face of the stock model. 

Note: Tool X and Z offsets that are required for each tool in the tool turret of a CNC turning center 

have to be measured from this point.  These tool offsets are necessary to be programmed in the 

controller correctly for proper cutting of the part when using an automatic tool turret in a CNC 

turning center. 
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Creating Machining Operations 

VisualTurn allows users to create machining operations for turning and hole making operations.  The 

user needs to make sure that all setups described previously have been completed before proceeding to 

creation of machining operations.  Additionally the user first needs to select the following items before 

proceeding with the program creation: 

1. Stock model if programming a roughing operation* 

2. Correct tool for the operation 

3. Choose the correct feeds and speeds setting 

4. Choose the clearance plane specification  

5. Part Region that defines the part to be machined. 

* A stock model is a pre-requisite only for creating Turn Roughing and Groove Roughing operations. 

All other operations can be created without first creating a stock model. 

Once all of these items have been created or made active machining operations can be created.  All 

turning operations can be accessed using the Machining Operations toolbar button in the toolbar 

belonging to the Mops tab of the browser as shown below. 
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All hole-making operations can be accessed using the Machining Operations toolbar button in the 

toolbar belonging to the Mops tab of the browser as shown below. 

 

Note:  Refer to previous chapter for a detailed description of each of the machining types 

 

A description of each of the objects needed prior to creating machining operations is detailed in the 

following sections of this chapter. 
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Turning Approach Types 

The approach type of an operation defines the axis (X or Z) about which the tool will approach the part 

for machining.  There are 3 types of approaches that are typically used.  These are Outer Diameter (OD), 

Inner Diameter (ID) and Front Facing (Face).  In the OD and the ID approach types the tool will 

approach and retract along the X axis.  In the case of OD the approach will be along the positive X axis 

while in the case of ID it will be along the negative X axis.  In Face approach the tool will approach and 

retract along the negative Z axis.  The approach type is a necessary parameter and will have to be 

defined in every turn operation in VisualTurn.  An example of setting the approach type in the 

VisualTurn turn finishing dialog is shown below: 
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Tools 

VisualTurn supports numerous types of turning and drilling.  To access the tools creation command, 

switch to the Tools tab in the browser window and select the first button in the toolbar. 

 

Selecting the Turn tool brings up the dialog shown below. Use the toolbar at the top of the tools dialog 

to select the desired tool type. 
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Various turn tool types such as  Turning inserts, grooving, threading and parting off tools can be created.  

The supported types are: 

 

     

Diamond Insert             Triangular Insert  

     

Circular Insert               Trigon Insert   
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Parallelogram Insert             Groove Insert 

  

     

Groove Chamfer Insert           Groove Round insert 
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K Thread Insert             Cut Off Insert (part off)  

Selecting the Drill tool brings up the dialog shown below. Again use the toolbar at the top of the tools 

dialog to select the desired tool type. 
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The supported drill tools include: 

     

     Standard Drill              Center Drill Tool   

 

 

     

Reamer Tool               Tap Tool 
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Bore Tool              Reverse Bore Tool 

 

Tool Library  

VisualTurn contains two tool library files - DefaultEnglishTools.vtl and DefaultMetri cTools.vtl. 

These files are located in the Data directory under the VisualTurn installation folder.  These files can be 

used as they are, or you can use them as templates and customize them with your own data. With 

VisualTurn you can save the tools you create to a library, which can be accessed by future files.  

Create/Save Tool library:  Once you create a set of tools they can be saved to an external file for future 

use.  Select the Tool / Save Tool Library button in the Tools tab toolbar of the Browser. 

 

Specify a folder location and assign a name. The default extension is *.vtl. Click Save. 
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Load Tool Library:  Created tool libraries can be loaded at any time into VisualTurn.  To do this select 

the  Tool / Load Tool Library button in the Tools tab toolbar of the browser. Select the *.vtl file you 

wish to load. 
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Feeds and Speeds 

You can set feeds and speeds for each operation.  You can do this before creating an operation by 

selecting the Feeds/Speeds dialog and entering in the desired values.  Alternatively, once the operation is 

created you can modify the feeds/speeds associated with the operation.  The Feeds/Speeds dialog is 

shown below. 

 

The various different values that can be set are as follows: 

Ç Spindle Speed: The rotational speed of the spindle, in RPM.  If the Constant Surface Speed is 

turned on, the controller would automatically calculate and adjust the spindle speed based on the 

current diameter of the work-piece. If this calculated spindle speed is greater than the maximum 

spindle speed specified, the spindle speed would be reduced to the maximum speed. 

Ç Max. Spindle Speed: The maximum rotational speed of the spindle, in RPM. 

Ç Plunge Feed:  The approach feed rate before the tool starts to engage in material. 

Ç Approach Feed: The pre-engage feed rate that prepares the tool just before it starts engaging 

into material, as it starts cutting. These tool motions are dependent on the machining method. 
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Ç Engage Feed: The feed rate as the tool starts engaging into material. By default this value is 

75% of the Cut Feed.  

Ç Cut Feed: The feed rate used when the tool is cutting. 

Ç Retract Feed: The feed rate as the tool stops cutting. By default, this is equal to Engage Feed.  

Ç Departure Feed: The post-engage feed rate that prepares the tool just as it stops cutting. 

Ç Transfer Feedrate: Specifies the feedrate of transfer motions (air motions). You can either use 

the Rapid setting of the tool, or set a custom feed rate. 

 

Customizing Feeds/Speeds: 

You can also load values from an external table by selecting Feeds/Speeds / Load Feeds/Speeds from 

the dropdown menu at the top.  

 

This will load the feeds and speeds from an external text file located in the Data folder under the 

VisualTurn installation folder.  Values for the feeds and speeds can be customized by the user.  For more 

information please refer to the on-line help of the product.  
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Clearance Plane  

The clearance plane is a plane from which the approach motions start and retract motions end. After 

retracting, the tool moves rapidly along this plane to the position of the next engage. This plane is 

typically a certain safe distance above the part geometry.  The Clearance plane dialog is accessed by 

clicking the Clearance Control button on the Mops tab toolbar.  

 

By default (Automatic option), the clearance level is calculated by adding a safety distance to the 

maximum radial point along the approach direction (depending whether Outer Diameter, Inner Diameter 

or Face is machined) found on both part and stock geometry. This safety distance is set to be the current 

tool radius. You can set the clearance level to be a specified distance from either the part or stock, or 

enter the absolute Z level. 

 

Turn OD Clearance Control 

The dialogs for ID and Face approach types are similar.  The only difference is that the clearance values 

are computed along different directions.  That is the clearance value will be computed along the negative 

X axis for ID approach type and along the positive Z axis for Face approach type. 
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Entry/Exit  

Entry and Exit determines the way in which tool enters and leaves the part geometry. VisualTurn allows 

the user to specify how the cutter approaches, engages, retracts and departs when starting and stopping a 

cut. The user can also specify the type of transfer motions to perform while cutting. 

The Entry motion consists of Approach and Engage. The user can set different feeds for plunge, 

approach, engage, cut, retract and depart moves. The tool moves to the position above the approach 

point with a plunge feed, then uses the approach feed rate for the vertical approach motion and engage 

feed rate for the engage motion. 

 

 

The approach can be either Tangential or at an angle to the Engage motion. This is followed by the 

engage motion that can be Tangential or at an angle. 
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Similarly the Exit motion consists of a Retract motion followed by a departure motion. The retract 

motion can be either Tangential or at an angle. The departure motion can be either Tangential or at an 

angle to the Retract motion.  

 

 

 

The user can also control the transfer motions during cutting. When the cutter has finished cutting in one 

region and needs to transfer to another region to begin cutting, it can either be instructed to move to the 

clearance plane and then perform the transfer motion to the next cut location or it could do a skim 

motion. In the skim motion, the system automatically determines the safe height by taking into 

consideration the condition of the regions and using this Skim Clearance (S) value specified as the 

height to perform the transfer motions. 
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Post-Processing 

Once a machining operation has been generated, it can be post-processed to a specific machine 

controller. VisualTurn comes with a set of post-processors to choose from. Each post-processor is 

represented by an *.spm file, all of which are located in the Posts folder under the VisualTurn 

installation folder. 

You can post-process an individual toolpath, or all toolpaths at once. For an individual toolpath, right-

click on its name in the Mops tab of the Browser and select Post. You can also click the Post Process 

icon on the Mops tab of the Browser. 

 

The entire list of toolpaths can be post-processed by right clicking the root folder in the Mops tab and 

selecting Post All. 

You can also output the toolpath in an APT standard Cutter Location (CL) file. APT is a widely 

accepted Numerical Control Machine standard. This CL file can then be used to create a machine 

specific post-processed output through any of the many commercially available APT post-processors. 

 

Post-Processor Problems 

If only two built in posts (APT CLS and Roland CAMM GL) are displayed in the selection dialog, then 

your Post folder is not set correctly.  Try the following: 

1. Select Post Process / Set Post Options. 

2. Click the Browse icon to change the folder where post-processor files are located.   

3. Select the Posts folder located in the VisualTurn installation folder. (Program 

Files\MecSoft Corporation\VisualTurn 1.0\Posts) 

4. Set the Program to use for displaying output file as notepad or WordPad. 
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If you are not able post process the toolpath: 

5. Under Post Process / Set Post Options.    

¶ Make sure Show Selection dialog when Post Processing is checked. 

¶ Make sure Post Process in Batch Mode is not selected. 

¶ Make sure Output Listing Files is not selected. 

Post the machining operations, making sure you are browsing to the Post folder in the VisualTurn 

installation folder. For the output file at the bottom, make sure there is a valid file name (valid path). 
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CAD Tutorial for creating a 2D profile for Turning  

As you have seen, you can import a ready-made part into VisualTurn. If you want to create your own 

part from scratch from within VisualTurn, the Geometry Bar contains all the CAD tools you need. 

F To set up the grid: 

1. Start a new file, switch to Top view, and display the grid. The default grid spacing, assuming you 

are working in inches, is 1ò. 

 

2. If you wish to change the grid settings, select Preferences / Grid Preferences to edit the grid 

spacing and grid extents. Choose grid spacing to 1.0 for this tutorial. 
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3. To create geometry with respect to the grid, you must be able to snap to grid points. In the lower 

right part of the screen, make sure Grid Snap is activated.  

 

F To create point regions: 

1. As youôve already seen in previous exercises, all geometry tools are in the Geometry Bar, 

located by default on the right side of the screen. In the Points category, click Point. 

 
 

2. Place the first point at 10ò to the right of origin. This is ten grid lines away, or you can look at 

the cursor location indicator at the lower right corner.  



Getting Started with VisualTurn  

 50 

 

3. Hide the grid and all coordinate systems, and you should be able to see the point clearly. 

 

F To create a part profile (Region): 

1. Set to the Top View 

2. Draw a 2D profile of the part using the CAD tools available from the geometry bar to the 

right of your screen.  

a. For Example: Switch to the Lines category and select Polyline. 

 

b. While the Polyline mode is active, start with the origin and choose the points of the 

part profile in succession. This would start building the part profile. Right-Click to 

indicate the end of the polyline. 
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c. You may use a combination of lines, polylines, and arcs to create geometry. 

3. Make sure the 2D profile be closed (touches X and Z axes) in the First Quadrant of the lathe 

coordinate system.  

4. Use the chain/join tool from the edit curves tab on the Geometry toolbar to join 2 or more 

lines/curves. 

 

5. The part is now ready for programming 

 

Example of a 2D profile created in VisualTurn 

6. The above 2D profile can be selected as a region for creating turning operations. 

7. Region for Hole Machining Operations 

a. A point region to indicate the starting location of the drilled hole or  

b. The above 2D profile can be select to create a drilled hole. (Visual Turn analyzes 

selected the 2D curve and determines the drill point where the 2D curve intersects the 

Z axis at X=0) 
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Creating Surfaces 

In this final section, the curves will be used to create the surfaces of the part. 

F To create the revolved surface: 

1. Select the 2D curve created from the above example. 

2. Click on Surface of Revolution surfaces and you would be prompted to enter/select the start 

point of the axis of revolution. 

Note: If no curves are selected and you pick Surface of Revolution, VisualTurn prompts you to select a 

2D curve and right click the mouse button when the selection is complete. 
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3. Pick the origin point as the start point and you would be prompted to enter/select the end point of 

axis of revolution. 

 

 

 

4. Select the end point  (see below) 

 

 

 

5. Enter the start angle as 0.0 and end angle as 360. 

 

 

6. Hit Enter and a surface of revolution is created. 
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F To change display settings:  

1. The part is located on the Default layer. If you want to change the color of the part, you must 

change the color of this layer. Click the Layers icon. 

 

2. In the Layer Manager, click the Color box to select a new color for the part. 
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Tutorial 1: Roughing & Finishing 

In this tutorial, you learn to create roughing and finishing toolpaths to program a designed part.  

The stepped instructions are accompanied by explanatory and introductory text. Reading this text will 

help you understand the tutorial methodology and provide information about additional options 

available. However, if you prefer to work straight through the steps without any additional reading, look 

for the following symbol: 

F 
Donôt forget to save your work periodically! You may want to save the file under a different name so 

that the original file will be preserved. 

Loading a Part Model 

ñPartò refers to the geometry that represents the final manufactured product. You can create parts within 

VisualTurn, but it is more typical to import geometry created in another CAD system.  

You can import solid models of Stereo-Lithography (both ASCII and binary) format files. Surfaces can 

be imported from IGES or Rhino 3DM. Faceted (triangulated) models can be imported from VRML, 

Raw Triangle, DXF / DWG facet data, or Rhino Mesh. Non-faceted geometry, once imported, is 

immediately converted and stored as triangulated data. 

Imported geometry is stored internally as a VisualTurn part file. This allows for much faster part loading 

time. 

F To load a part:  

1. Select File / Open, or click the Open Part File icon from the Standard bar. 

 

2. From the Open dialog box, select the Tutorial -1.vtp file from the Tutorials  folder in the 

VisualTurn installation folder 

The imported part appears as shown below. 
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VisualTurn also allows you  

¶ Create 2D profiles using the CAD features 

¶ Import 3D CAD files in standard format. However, these 3D files have to be sliced to 

reduce them to 2D profiles. 

Note: Refer to our CAD section for help on creating 2D profiles and other CAD tools 

F To slice a part and resolve part region  

3. Once the part is loaded click on the Slice 3D Part on the Setup bar of the Browser.  



  Version 1.0 

 57  

 

4. This slices the 3D file into a 2D profile. 

 

3. Select the 2D profile and click Resolve part region to extract the curves to First quadrant of the 

lathe coordinate system (X and Z axes) 
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4. The resolved 2D curve appears as shown below 

 

5. You may now save the file and start creating VisualTurn machining operations. 

 

F To create the stock: 

1. Select Create/Load Stock from the Setup tab of the Browser and select Cylinder Stock. (This 

tool is also available on the Stock tab of the Browser.) 
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2. In the Cylinder Stock window, you can enter the radius and length of the stock. Enter the values 

as shown in the illustration below. Click OK . 

 

3. The stock model is created. To display the stock, click the Stock tab of the Browser. The stock is 

displayed as a cylinder positioned at the reference point of the lathe machine. Its color can be set 

in the Color Preferences. 
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(The simulation settings are set to 3-quarter view) 

4. If you donôt see the stock, make sure the Hide Stock toggle icon in the View bar is not pressed.  

 

5. To change simulation setting click on the Simulation Settings on the Stock tab. For more help 

look under simulations settings in the user manual. 

Tip: Stock is used for simulation, and its display involves data-intensive rendering. This can slow down 

VisualTurnôs performance. Therefore, we recommend turning off the stock display when not needed. 



  Version 1.0 

 61  

Note: You must define a stock model before creating Roughing and Groove Roughing operations. All 

other operations can be created without first creating a stock model. 

Creating Tools 

F To create the roughing tool: 

1. Select Tool / Create/Select Turn Tool, or click the Create/Select Turn Tool icon on the Tools 

tab of the Browser. 

 

2. In the Select/Create Turn Tool window, click the Diamond tab. Change the name to Rough 

Tool and Tip Radius to 0.1ò. Choose the default values for other parameters and click Save as 

New. 
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F To create the finishing tool: 

Finishing is typically performed with a smaller radius tool.  

1. While still in the Diamond tab, change the tool diameter to 0.01 inches.  

2. Change the tool name to Finish Tool.  

3. Click Save as New. 
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4. Click Close to close the window. 

5. Now that all tools have been created, click the Tools tab in the Browser. All the tools are listed. 

 

Note: You can double-click on any tool to open its definition window. This is an easy way to make 

changes, if needed. 

To see the information of all tools, click on the Tools Info icon or right-click on the Tools header and 

select Information or click on the Tools Info from the tools tab.  
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This displays a table listing the properties of all the tools youôve defined. 

 

F To create the tool library: 

You can save the tools in the list to a library, which can be accessed by future files. 

1. A group of tools can be saved to a library file for future use. Select Tool / Save Tool Library or 

click the icon in the Tools tab of the Browser. 
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2. In the default folder (should be Tutorials , which contains the part file), assign the name 

OD_Turn Tools. The default extension is *.vtl. Click Save. 

3. Right-click on the Tools header in the Browser and select Delete All. 

 

4. To replace the tools, select Tool / Load Tool Library . Select the *.vtl file you just saved, and 

the tools reappear in the file. 
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F To set the Machine Co-ordinate System: 

5. Click on the Set MCS icon in the Mops tab of the Browser Bar or Double-Click on the Set MCS 

under Machining Operations  

 

6. This gives the user different options to set the machine zero. The user can set the zero to the 

left/right face of the part/stock box or pick the point directly. 

7. For this example, set the MCS origin to the Stock Box and Zero Face to Right Most face of the 

stock. Click OK .   
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F Selecting the Tool for Roughing Operation 

1. Under the Mops tab click on Create/Select Turn tool 
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2. From the tool select dialog pick the Rough tool and click select tool. This will make the Rough 

tool as the active tool and shows up in the status bar at the bottom of the screen 

 

 

F Setting Feeds and Speeds 

You can set toolpath feeds and speeds and customize these settings for later use. To set the feeds and 

speeds click on Set Feeds/Speeds on the Mops tab. This launches the Feeds/Speeds dialog. Considering 

the Stock material as Aluminum and the Tool material to be HSS for the above example. 
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Once you have set the Speeds and Feeds click OK to continue. 

These feeds and speeds will be used during the post-processing of the toolpath.  

 



Getting Started with VisualTurn  

 70 

Creating the Outer Diameter Roughing Toolpath 

In this type of toolpath, VisualTurn uses stock geometry and part geometry to determine the machining 

region. The safe machining region is the region in which the tool can safely traverse removing stock. 

Once this machining region is determined, a tool traversal pattern such as a zigzag or offset machining 

cut pattern can then be applied to remove stock.  

Regions are curves that already exist in the model, or curves you create within VisualTurn. In the Setup 

tab of the Browser, you will see that one region already exists in this file. 

F Setting Clearance Plane 

The clearance plane is a plane from which the approach motions start and retract motions end. After 

retracting, the tool moves rapidly along this plane to the position of the next engage. This plane is 

typically a certain safe distance above the part geometry. Clicking the Clearance Control button on the 

Mops tab sets clearance levels. By default the Clearance Distance is set to automatic. 
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F To create the Outer Diameter Roughing toolpath: 

1. Once you have the tool selected and feeds and speeds set, you now have to select the region (2D 

profile of the geometry).  

2. Go to Select Regions and use single select to select the 2D profile 
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3. Click on the curve/polyline. This adds to the Selections Regions dialog. Click OK to complete 

selection. 

4. Select Turning / Roughing, or click the Machining icon on the Mops tab of the Browser, and 

then select Turning / Roughing. 
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5. The Roughing window opens, in which you can set parameters for the toolpath.  

6. In the Global Parameters tab, set the Approach type to Outer Diameter, the Stock value is set 

to 0.01 inches. This value defines the thickness of the layer that will remain on the part after the 

tool-path is complete. Roughing operations generally leave a thin layer of stock, but for finishing 

operations this value is zero. 

 

7. Select Containment Rectangle lets you create containment region if you wish to restrict the 

toolpath to a certain area only. To accomplish this Check Select Containment Rectangle button 

to enable the pointer that allows you to pick the containment rectangle. Click on the pointer to 

specify the region, defined by a rectangle. In this operation we will not be using a containment 

Rectangle. 

 

8. In the Roughing Parameters tab, set the Cut Pattern to Linear, uncheck Final Cleanup Pass 

and set Depth per Cut to 0.1. 
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9. Leave the remaining parameters in the other tabs as they are, and click Generate, located at the 

bottom of the window.  

The window will disappear and an hourglass cursor will appear on the screen. When the computation 

is complete, the roughing toolpath will appear. 

 

 

 

 

 

Note: See reference section for help on setting up Entry/Exit parameters 


































































































































